1. Overview

The Aphrodite Shoe Company now makes three kinds of women’s running shoes. The company needs to drop one shoe from its product line. In addition, the company wants to subcontract some of its manufacturing to an offshore company to take advantage of lower wages overseas. In this case, you will use Excel to help management decide which running shoe to drop from its product line and how much production to move offshore.

For this project you are to develop a spreadsheet to analyze the problem and write a memorandum describing your findings. You must work in a group of 2 or 3 students. You will lose 50 points (out of 100) if you do the project by yourself.

2. Background

Aphrodite Shoe Company makes women’s running shoes. Introduced 20 years ago, the Aphrodite line has three styles of shoes, each of which sells well. Many companies selling running shoes have gone out of business during that time, but Aphrodite survived.

Management now thinks that the product line needs to be trimmed. They need to plan for this at year-end 2009. Production and marketing would be revised starting in 2010. Management thinks that only two shoe styles should be produced and marketed, but management is having trouble deciding which one of the three shoe styles to drop.

To date, Aphrodite has produced shoes only in America, and their plants are unionized. Labor rates are much lower overseas, however. Because shoe companies that lose control of their costs cannot survive in the long run, management thinks the company should produce some shoes overseas, starting in 2010. Below, the following issues are fully discussed:

- Marketing considerations
- Manufacturing opportunities
- Production and marketing cost data

3. Marketing Considerations
Currently, Aphrodite produces three shoes: (1) the “Genre1,” their current top-of-the-line shoe; (2) the “Genre2,” another high-quality but somewhat lower-priced shoe; and (3) the “Gestalt,” a durable, reasonably priced low-end shoe.

Marketing management has learned that consumers get confused if there are too many shoe choices. Each shoe, in effect, competes with other shoes in the company’s own product line. Obviously, that is not a good thing, and it is one reason to streamline the product line. Even with only two products, however, management thinks that there would be some product-to-product effects, which management has dubbed the “cannibalization problem.” Simply put, this means that one shoe style’s appeal would cut into the sales of another shoe style.

Marketing surveys have quantified the cannibalization effect for Aphrodite’s shoes. Management thinks that the company can make and sell 2 million pairs of shoes per year in 2010, 2011, and 2012. Without any cannibalization, the company’s marketing forecasters think that 1 million of each of the company’s two products (whatever they turn out to be) would be sold. On the other hand, with sales subject to the cannibalization effect, management expects the following scenarios:

- If just the Genre1 and Genre2 shoes are produced and sold, many customers will think the products are about the same and will just opt to buy the lower-priced shoe. Because the less-expensive Genre2 would cannibalize some of the market for Genre1, 30% of the 2 million pairs made and sold would be the Genre1, and 70% would be the Genre2.

- If the very different Genre1 and the Gestalt shoes are produced, some customers will still be distracted from the high-end of the line by the Gestalt (which really is a nice-looking shoe). So, 48% of the 2 million pairs sold would be Genre1 and 52% would be Gestalts.

- If Genre2 and the Gestalt shoes are produced, many customers will believe that the Gestalt is about as good as the Genre2. Thus, 55% of the 2 million sales would be for Gestalts, leaving 45% of sales for Genre2.

Whether or not production is moved offshore, the same cannibalization rates apply. For example, assume that 50% of production moves offshore, and the Genre1 and the Genre2 are produced. One million pairs of shoes would be produced in the U.S., and 1 million pairs would be produced overseas. Thus, 30% of the 1 million pairs made and sold in the U.S. would be Genre1, and 70% would be the Genre2; similarly, 30% of the 1 million pairs made overseas would be the Genre1 and 70% would be the Genre2.

4. Manufacturing Opportunities

Aphrodite has made all its shoes in the United States, but labor costs overseas are much lower than those in the U.S. Thus, Aphrodite’s management has decided to make some of their shoes offshore, but
out of loyalty to U.S. workers, management does not want to move all production offshore. Management needs to decide how much production to move.

Offshore production would be in Puerto Rico. A Puerto Rican manufacturer offers to make shoes at a fixed rate per pair, delivered to the U.S. This rate appears to be lower than the total of U.S. manufacturing cost. The details of the offer are discussed next.

5. Production and Marketing Cost Data

Several cost factors must be considered when creating a running shoe. For instance, a running shoe must have a shock-absorbing sole. In 2009, the cost of soles for a pair of shoes was $12 (i.e., $12 for the two soles in a pair of shoes). The cost was the same for the Genre1, the Genre2, and the Gestalt. The cost of soles is expected to go up at the rate of inflation in each of the next three years.

In addition, a running shoe must also have a tough-but-flexible to part, called the “upper.” In 2009, the cost was $13 (i.e., $13 for the two uppers in a pair of shoes). The cost was the same for the Genre1, the Genre2, and the Gestalt. The cost of uppers is expected to go up at the inflation rate in each of the next three years.

A running shoe has all sorts of miscellaneous materials, such as the laces, eye-holes for the laces, trim, and so on. In 2009, the cost of a pair of shoes’ miscellaneous materials was $5. The cost was the same for the Genre1, the Genre2, and the Gestalt. The cost of miscellaneous materials is expected to go up at the inflation rate in each of the next three years.

The Genre1 and the Genre2 have supporting ribs around the bottom of the sole that control how much the shoe twists on impact with the ground. This is called a “stabilizer.” In 2009, the cost of a pair of shoes’ stabilizers was $17. The cost was the same for the Genre1 and the Genre2. The cost of stabilizers is expected to go up at the inflation rate in each of the next three years.

The Genre1 comes with material that snugly cups the foot’s heel and Achilles tendon, thus giving added support. This material is called the “hugger.” In 2009, the cost of a pair of shoes’ huggers was $8. The cost of huggers is expected to go up at the inflation rate in each of the next three years.

The cost data is summarized in the following table. In the table, the letter ‘X’ means the shoe includes the component.
As was mentioned, costs are expected to go up at the rate of inflation. The inflation rates expected are 2%, 3%, and 4% in years 2010, 2011, and 2012, respectively.

In 2006, the cost of hand labor per pair of shoes manufactured in the U.S. was $6. The cost was the same for the Genre1, the Genre2, and the Gestalt. The cost is expected to be the same in 2010 but will rise to $7 per pair in 2011 and $8 per pair in 2012.

There are other costs incurred when making shoes. The plant’s machines must be set up beforehand to cut, mold, and bind the materials. Then many pairs of the same shoe will be made in long production runs. Set-up costs differ for each kind of shoe. In 2010, set-up costs per pair of shoes are expected to be as follows:

- Genre1: $5
- Genre2: $4
- Gestalt: $6

Each pair of shoes manufactured in the U.S. incurs a set-up cost. Each of these costs is expected to increase in the years that follow.

The company has high fixed administrative costs. For example, famous athletes and rock stars must be wined and dined to get their endorsements! Hanging out with celebrities who wear your running shoes is very hard work, and it costs a lot of money to convince them to wear your shoes. Other costs include depreciation on the manufacturing site’s building and equipment, management salaries, and so forth. These costs are expected to be as follows

- 2010: $18 million
- 2011: $18.5 million
• 2012: $19 million

Advertising expenses are also very high in the shoe business. Advertising costs are expected to be $30 million in 2010 and then to go up by $3 million a year each year thereafter.

The Puerto Rican manufacturing company that has approached Aphrodite offers to make Aphrodite running shoes exactly to Aphrodite’s specifications---but for much less than the U.S. cost of manufacturing. The Puerto Rican company does this kind of “outsourcing” for other shoe companies, and the testimonials from these other companies are glowing! The Puerto Rican company has enough manufacturing capacity to manufacture 100% of Aphrodite’s shoe requirements, but it will take any amount of work that Aphrodite sends its way.

Aphrodite’s management has dubbed this the “offshore” manufacturing option. It is quite attractive. The Puerto Rican company has offered to make a pair of shoes for the following prices:

• $50 a pair in 2010
• $55 a pair in 2011
• $60 a pair in 2012

The rates apply to all three types of Aphrodite shoes. The rates are probably going to be cheaper than the cost of materials, labor, and set-up in the U.S. during those years.

Some of Aphrodite’s management, sensitive to union relationships, assert that the company should send no more than 25% of its requirements to Puerto Rico in each year. Others in Aphrodite, sensitive to the bottom line, claim that 25% of their shoes should be made in Puerto Rico in 2010, 50% in 2011, and 75% in 2012.

Regardless of where the shoes are manufactured, the selling price of a pair of shoes will be the same. In 2009, the Genre1’s selling price was $100, the Genre2’s selling price was $85, and the Gestalt’s selling price was $65. Selling prices are expected to go up at the rate of inflation during the next three years.

Aphrodite management wants to drop one line of shoes, but they are not sure which one. In addition, management wants to “offshore” some of the company’s production, but they are not sure how much. You must build a spreadsheet model of the situation so you can play “what if” with the variables. Management’s chosen strategy is to obtain the combination of product lines and offshoring rates that give the highest 2012 net income after taxes, the highest accumulated cash at 12/31/2012, and the lowest bank debt at 12/31/2012.

As you can see, this is a complicated situation for Aphrodite. This is where your decision-support system comes in! Your model will let you play “what if” with the different factors, then report to management on which strategy leads to the highest income and cash, and the lowest debt.
6. Creating a Spreadsheet for Decision Support

In this assignment, you will first produce a spreadsheet that models the business decision. The model is an income statement and cash-flow forecast for the years 2010 to 2012. Your spreadsheet should have the sections that follow. You will be shown how each section below should be set up before entering the cell formulas.

- TITLE
- CONSTANTS
- INPUTS
- SUMMARY OF KEY RESULTS
- CALCULATIONS
- INCOME STATEMENT AND CASH-FLOW STATEMENT
- DEBT OWED

A discussion of each spreadsheet section follows. Make sure your spreadsheet (including cell numbers) matches exactly with what is shown in the following figures. You will lose many points if you do not set up your spreadsheet exactly as shown.

6.1. TITLE Section

Your spreadsheet should begin with a title on the first two lines, followed by a list of all of the members in your group, as shown below:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>CS 103, Fall 2009</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Aphrodite Running Shoes</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>GROUP MEMBERS</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>1.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>2.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>3.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

6.2. CONSTANTS Section

Your spreadsheet should have the following constants, which are explained below the figure:
• TAX RATE and INTEREST RATE FOR YEAR are not expected to change in the three years.

• Management thinks that they can make and sell 2 million pairs of shoes in each year. This would include any shoes made offshore.

• FIXED ADMINISTRATIVE EXPENSES do not vary with production levels. They will go up somewhat each year.

• The INFLATION RATE is expected to go up each year. Selling prices and many costs are expected to go up at the inflation rate.

• The U.S. SET-UP COST PER PAIR will go up a bit each year, as you can see. The set-up cost applies only to shoes made in the U.S.

• The COST OF U.S. HAND LABOR PER PAIR will go up each year.

• ADVERTISING EXPENSES increase each year as shown.

• The MINIMUM CASH NEEDED AT END OF CURRENT YEAR TO START NEXT YEAR is the amount of cash that Aphrodite needs at the end of the current year to start the next year. The minimum amount for each year is $10 million. A banker will lend the company enough to stay at that level if there are cash-flow problems.
• The Puerto Rican company offers to make shoes at a flat rate. This rate is called the OFFSHORE MANUFACTURING COST. The rate is per pair of shoes.

6.3. INPUTS Section

Your spreadsheet should have the inputs shown below. An explanation of the line items follows the figure. (“NA” means that the cell should not be used, and the cell address should not be referred to in any formula in the spreadsheet.)

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>24</td>
<td>INPUTS</td>
<td>2009</td>
<td>2010</td>
<td>2011</td>
</tr>
<tr>
<td>25</td>
<td>OFFSHOREING METHOD: ENTER % MADE OFFSHORE (e.g., 50)</td>
<td>NA</td>
<td></td>
<td></td>
</tr>
<tr>
<td>26</td>
<td>SHOE NOT MADE: GENRE1 (G1), GENRE2 (G2), GESTALT (GS)</td>
<td>NA</td>
<td></td>
<td>NA</td>
</tr>
</tbody>
</table>

• If the company “offshores” 25% of production in each year, the user would enter 25, 25, and 25. If the company “offshores” 25%, 50%, and then 75% of production, enter 25, 50, and 75.

• For the shoe product variable, you make only one entry---for the shoe that will be discontinued. Example: Entering “G1” means that the Genre1 shoe will not be made, and the Genre2 and the Gestalt products will be made. One entry denotes the choice for the three-year period.

• Apply Conditional Formatting to the input cells, so out-of-bounds values are highlighted in some way (in red type and/or in boldface type). For example, no offshoring amount can be greater than 100 or less than zero. Hint: G1, G2, and GS are the only allowable values for the shoe not made. For that input, you will need to specify a formula that uses the Excel =AND() function.

6.4. SUMMARY OF KEY RESULTS Section

Your spreadsheet should show the following results:
For each year, your spreadsheet should show (1) NET INCOME AFTER TAXES, (2) END-OF-THE-YEAR CASH ON HAND, and (3) END-OF-THE-YEAR DEBT OWED. These values are computed in other parts of the spreadsheet and echoed to this section. Results in this section should be formatted for zero decimals (i.e., no pennies).

6.5. CALCULATIONS Section

You should calculate the intermediate results, which are then used in the section INCOME STATEMENT AND CASH FLOW STATEMENT. Calculations, shown in the below two figures, are based on input values or on 2009 values. Use absolute addressing when called for. Selling prices and raw material costs per pair should be formatted for two decimals, and the other results in this section should be formatted for zero decimals (i.e., no pennies). An explanation of the line items follows the figure.
<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CALCULATIONS</strong></td>
<td><strong>2009</strong></td>
<td><strong>2010</strong></td>
<td><strong>2011</strong></td>
<td><strong>2012</strong></td>
</tr>
<tr>
<td><strong>SELLING PRICE PER PAIR:</strong></td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>GENRE1</td>
<td>100.00</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>GENRE2</td>
<td>85.00</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>GESTALT</td>
<td>65.00</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td><strong>U.S. RAW MATERIAL COSTS PER PAIR:</strong></td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>SOLE</td>
<td>12.00</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>UPPER</td>
<td>13.00</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>HUGGER</td>
<td>8.00</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>STABILIZER</td>
<td>17.00</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>MISCELLANEOUS</td>
<td>5.00</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td><strong>NUMBER OF PAIRS MADE OFFSHORE</strong></td>
<td>NA</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td><strong>NUMBER OF PAIRS MADE IN U.S.:</strong></td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>GENRE1</td>
<td>NA</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>GENRE2</td>
<td>NA</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>GESTALT</td>
<td>NA</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td><strong>NUMBER OF PAIRS MADE IN TOTAL:</strong></td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>GENRE1</td>
<td>NA</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>GENRE2</td>
<td>NA</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>GESTALT</td>
<td>NA</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

• SELLING PRICE PER PAIR for all styles is expected to increase at the rate of inflation.

• RAW MATERIAL COSTS PER PAIR for all styles are unit costs for the various raw material inputs. They are also expected to increase at the rate of inflation.

• The NUMBER OF PAIRS MADE OFFSHORE in a year is a function of the total pairs made (a constant) and the percentage of production “offshored” (an input).

• The NUMBER OF PAIRS MADE IN U.S. and the NUMBER OF PAIRS MADE IN TOTAL depend on which shoes are chosen, and that depends on the input for the shoe to be dropped from production. The number of shoes made in the U.S. is then a function of (1) the cannibalization effect (discussed previously) and (2) the total shoes made, less those produced offshore. Obviously, a discontinued shoe style will have a production level of zero.

A discussion of the continued CALCULATIONS SECTION below follows the next figure.
• OFFSHORE MANUFACTURING COSTS are a function of the number of shoes made in Puerto Rico and the per-shoe rate for the year.

• U.S. MANUFACTURING COSTS for each input are a function of the number of shoes made in the U.S., the kind of shoe made, and the per unit cost in the year. The per unit cost is a calculation. Note that you are calculating total dollar amounts here, not unit costs.

• U.S. SET-UP COSTS are a function of the number of shoes made in the U.S. and the per unit set-up cost in the year.

• REVENUE is a function of the total number of pairs of shoes made and sold and the unit selling price. The number of each kind made and sold is a calculation, as is the selling price.

6.6. INCOME STATEMENT AND CASH FLOW STATEMENT Section

The forecast for net income and cash flow starts with the cash on hand at the beginning of the year, is followed by the income statement, and concludes with the calculation of cash on hand at the year’s end. Results in this section should be formatted for zero decimals (i.e., no pennies). Your spreadsheet section should contain the line items shown in the following two figures. A discussion of the line items follows the figures.
• BEGINNING-OF-THE-YEAR CASH ON HAND is the cash on hand at the end of the prior year.

• TOTAL REVENUE is the sum of revenues for all shoes.

• U.S. SET-UP COSTS are the sum of all U.S. set-up costs, which are calculations.

• U.S. MANUFACTURING COSTS are the sum of all the U.S. manufacturing costs, which are calculations.

• OFFSHORE MANUFACTURING COSTS are a calculation.

• ADVERTISING EXPENSES and FIXED ADMINISTRATIVE EXPENSES are constants.

• TOTAL COSTS AND EXPENSES is the sum of the costs of U.S. SET-UP COSTS, the U.S. MANUFACTURING COSTS, the OFFSHORE MANUFACTURING COSTS, the ADVERTISING EXPENSES, and the FIXED ADMINISTRATIVE EXPENSES.

• INCOME BEFORE INTEREST AND TAXES is the total revenue minus the total costs and expenses.

• INTEREST EXPENSE is based on the year’s interest rate and debt owed at the beginning of the year.
• INCOME BEFORE TAXES is calculated as the INCOME BEFORE INTEREST AND TAXES minus the INTEREST EXPENSE.

• INCOME TAX EXPENSE is zero if INCOME BEFORE TAXES is zero or less; otherwise, apply the tax rate to INCOME BEFORE TAXES to determine the tax expense.

• NET INCOME AFTER TAXES is calculated as INCOME BEFORE TAXES minus INCOME TAX EXPENSE.

Continuing this statement, line items for the year-end cash calculation are now discussed. Column B is for year 2009, Column C for 2010, and so on.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>NET CASH POSITION (NCP) BEFORE BORROWING AND REPAYMENT OF DEBT (BEGINNING-OF-THE-YEAR CASH PLUS NET INCOME AFTER TAXES)</td>
<td>NA</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ADD: BORROWING FROM BANK</td>
<td>NA</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LESS: REPAYMENT TO BANK</td>
<td>NA</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>EQUALS: END-OF-THE-YEAR CASH ON HAND</td>
<td>1000000</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

• Year 2009 values (column B) are mostly NA, expect for the END-OF-THE-YEAR CASH ON HAND, which is $10 million and happens to equal the minimum cash needed to start the next year.

• The NET CASH POSITION (NCP) at the end of a year equals the cash at the beginning of the year, plus the year’s net income after taxes. (Assume that there are no receivables or payables.)

• Aphrodite’s bank will lend it enough money at the year’s end to get the minimum cash required to start the following year. If the NCP is less than the minimum cash required, then the company must borrow enough cash to reach the minimum cash required.

• If the NCP is more than the minimum cash required at the end of a year and there is outstanding debt, then as much debt as possible should be repaid (but not to take the company below the minimum cash).

• END-OF-THE-YEAR CASH ON HAND equals the NCP, plus any borrowing, less any repayment.

6.7. DEBT OWED Section
Your spreadsheet body ends with a calculation of debt owed at the year’s end, as shown in the figure below. An explanation of line items follows the figure.

<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>92</td>
<td>DEBT OWED</td>
<td></td>
<td></td>
</tr>
<tr>
<td>93</td>
<td>BEGINNING-OF-THE-YEAR DEBT OWED</td>
<td>NA</td>
<td></td>
</tr>
<tr>
<td>94</td>
<td>ADD: BORROWING FROM BANK</td>
<td>NA</td>
<td></td>
</tr>
<tr>
<td>95</td>
<td>LESS: REPAYMENT TO BANK</td>
<td>NA</td>
<td></td>
</tr>
<tr>
<td>96</td>
<td>EQUALS: END-OF-THE-YEAR DEBT OWED</td>
<td>20000000</td>
<td></td>
</tr>
</tbody>
</table>

- Year 2009 values are mostly NA, except that $20 million was owed to the bank at the year’s end.
- Cash owed to the bank at the start of a year (BEGINNING-OF-THE-YEAR DEBT OWED) equals cash owed to the bank at the end of the prior year.
- Amounts borrowed and repaid have been calculated in other parts of the spreadsheet and are echoed to this section.
- The amount owed at the end of a year equals the amount owed at the beginning of the year, plus any borrowing, and less any repayment.

7. Using the Spreadsheet for Decision Support

You will now complete the project by (1) using the spreadsheet to gather the data needed to make the manufacturing and marketing decisions, and (2) documenting your recommendation in a memorandum.

Some in management think that the offshoring decision should not take away too much work from the company’s unionized workers. Others in management think that offshoring should be more aggressively pursued. With respect to the product lines, different managers champion different products. Assume that management (and the bank) are interested in six possibilities:

- Outsource 25% each year; drop the Genre1. Call this scenario “Union-G1”.
- Outsource 25%, 50%, then 75%; drop the Genre1. Call this scenario “Mgmt-G1”.
- Outsource 25% each year; drop the Genre2. Call this scenario “Union-G2”.
- Outsource 25%, 50%, then 75%; drop the Genre2. Call this scenario “Mgmt-G2”.
- Outsource 25% each year; drop the Gestalt. Call this scenario “Union-GS”.
- Outsource 25%, 50%, then 75%; drop the Gestalt. Call this scenario “Mgmt-GS”.

Run “what if” scenarios with the six possible input values (Union-G1, Mgmt-G1, Union-G2, Mgmt-G2, Union-GS, Mgmt-GS). Use Excel’s Scenario Manager to perform the analysis. (To start the
Scenario Manager, navigate Tools > Scenarios ... in Excel 2003. In Excel 2007, click on the Data tab, and in the Data Tools section, click on What-If Analysis.) Record the six possible scenarios (Union-G1, Mgmt-G1, etc.) in the Scenario Manager, where the changing cells are the two cells used to input the offshoring and product values. The result cells are for 2012 values only: 2012 net income, cash on hand at the end of 2012, and debt owed at the end of 2012. Also, graph the results for all the combinations for 2012.

8. Document Your Recommendations in a Memorandum

Use Microsoft Word to write a memorandum to Aphrodite’s marketing and manufacturing managers, who want to know which offshoring and product-line strategies seem best for the company. The managers want answers to these questions:

- Do the financial results clearly point to dropping one product in favor of the other two? That is, does one combination of styles lead to much better net income, cash, and debt results in 2012? How much better?

- Presumably, more offshoring leads to better financial results. There are two possibilities regarding this assumption: (1) If that assumption is not correct in some scenarios, point out that fact. (2) However, if the assumption is correct in all scenarios, then point out any scenarios in which favoring the “Union” gives results that are close to favoring “Management.” “Close” could be defined as “Union” 2012 net income or cash levels within $5 million of the “Management” amounts. Conceivably, management would opt to keep the Union happy---if the financial penalty for doing so was not great.

If management knows the answers to these questions, they can decide which combination of products and offshoring is best for the company in the long run. When you write your memorandum, observe the following requirements:

- Your memorandum should have a proper heading (DATE / TO / FROM / SUBJECT). You may wish to use a Word memo template (File – New, click General Templates, click Memos, choose Contemporary Memo). Your memo must not exceed 2 pages.

- In the first paragraph, tell the managers which strategy you recommend and why. You should recommend any strategy that clearly produces the best financial results, of course. However, if two or more strategies seem “tied” for best, state that and explain why you would favor one over the others.

- You should go on to answer the Marketing and Manufacturing managers’ questions. Point out any scenarios that would keep the company’s union happy at a small financial penalty, if any.

- Support your statement using graphs.
- Enter a table into Word summarizing your findings as follows:

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Favor Union, Produce:</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Genre1 and Genre2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Genre1 and Gestalt</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Genre2 and Gestalt</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Favor Management, Produce:</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Genre1 and Genre2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Genre1 and Gestalt</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Genre2 and Gestalt</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- In addition to your memo, provide a printout of your spreadsheet for the Union-G1 combination. Also provide a printout showing all of the formulas for the Union-G1 combination. (Excel can display all of the formulas as follows. In Excel 2003, navigate **Tools > Formula Auditing > Formula Auditing Mode**. In Excel 2007, click on the **Formulas** tab, and in the **Formula Auditing** section, click on **Show Formulas**.) Also, include a printout of the Scenario Summary sheet that the Scenario Manager produced.

- All of your documents must be stapled together.